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BAB III 

METODE PENELITIAN 

 

A. Jenis dan Pendekatan 

Penelitian ini menggunakan pendekataan kuantitatif 

dengan menekankan pada analisis data numerik (angka) 

kemudian diolah secara statistik. Jenis penelitian yang 

digunakan adalah penelitian pre-experimental artinya, 

penelitian dilakukan hanya dengan satu kelompok, atau sering 

disebut sebagai kelompok eksperimen tanpa kelompok 

pembanding atau control.
 1

 Penelitian tersebut dapat digunakan 

untuk mengetahui pengaruh suatu perlakuan tertentu terhadap 

perlakuan lain dalam kondisi yang terkendali. Jenis penelitian 

ini menggunakan pre-experimental design type one group 

pretest-posttest yaitu penelitian yang  dilakukan dalam satu 

kelompok, dengan diberikan tes awal (pretest) sebelum 

perlakuan, kemudian tes akhir (posttest) dilakukan setelah 

diberikan perlakuan. Dengan demikian dapat diketahui bahwa 

penelitian lebih akurat karena dapat dibandingkan sebelum dan 

sesudah mendapat perlakuan. 

 

B. Waktu dan Tempat Penelitian 

Penelitian ini dilaksanakan di MTs Nu Ibtidaul Falah yang 

terletak di jalan Geringging, Samirejo, Kecamatan Dawe, 

Kabupaten Kudus pada semester Genap tahun ajaran 

2020/2021 di kelas VIII-A. Waktu pelaksanaan penelitian 

dilakukan pada saat pemberian materi sistem pernapasan 

manusia yaitu sekitar bulan Oktober-November Tahun 2021. 

Waktu penelitian telah disesuaikan dan disepakati oleh pihak 

MTs Nu Ibtidaul Falah. Alasan penulis memilih lokasi ini 

karena sekolah tersebut mempunyai kriteria untuk dilakukan 

penelitian yaitu adanya kesulitan dalam memahami materi 

pembelajaran yang sekarang sedang dilakukan secara online 

sehingga berdampak pada hasil belajar. Oleh karena itu, perlu 

dilakukan penelitian di sekolah ini mengenai dampak 

penggunaan media pembelajaran berupa video sebagai solusi 

untuk membantu memahami materi pembelajaran dimasa 

                                                           
1 Sugiyono, Metode Penelitian Pendidikan Pendekatan Kuantitatif, 

Kualitatif, R&D, 27th edn (Bandung: Alfabeta, 2018). 109. 



38 

pandemi covid-19. Selain itu, penulis juga telah berkoordinasi 

dengan guru pengampu mata pelajaran IPA di sekolah tersebut 

 

C. Populasi dan Sampel  

Pada penelitian ini populasi meliputi seluruh peserta didik 

di kelas VIII MTs Nu Ibtidaul Falah pada semester genap tahun 

ajaran 2020/2021. Jumlah populasi yang terdapat pada sekolah 

tersebut di kelas VIII terbagi dalam 9 kelas yaitu terdiri dari 

kelas VIII A, VIII B, VIII C, VIII D, VIII E, VIII F, VIII G, 

VIII H, dan VIII I. Dalam penelitian ini teknik sampling yang 

digunakan untuk mengambil sampel adalah dengan teknik 

Probability Sampling pada jenis random sampling. Sampel 

adalah bagian dari suatu populasi yang diperoleh dengan cara 

mempunyai ciri-ciri tertentu yang dianggap mewakili populasi 

tersebut.
2
 Teknik random merupakan langkah yang dilakukan 

untuk mengambil sampel dengan cara  undian. Teknik ini 

dilakukan dengan cara sebagai berikut: potong kertas kecil dan 

tuliskan nama masing-masing kelas pada kertas. Gulung 

potongan kertas tersebut dengan nama kelas kemudian 

masukkan dalam botol lalu kocok. Gulungan pertama akan 

digunakan sebagai sampel untuk kelas penelitian. Hasil 

pengundian sebagai sampel penelitian ini adalah Kelas VIII-D 

MTs Nu Ibtidaul Falah tahun ajaran 2020/2021 dengan jumlah 

peserta didik 37 orang. 

 

D. Desain dan Definisi Operasional 

1. Desain Penelitian 

Pada penelitian ini desain penelitian yang digunakan 

adalah pre-experimental tipe one group pretest-posttest. 

Desain tersebut merupakan suatu desain penelitian yang 

terdapat pretest atau latihan awal sebelum diberi suatu 

perlakuan, kemudian setelah diberi perlakuan peserta didik 

akan diberikan posttest atau tes akhir. Secara sederhana, 

rancangan desain penelitian one group pretest-posttest 

terdapat pada gambar 3.1. 

 

 

                                                           
2 Gulo W, Metode Penelitian, (Jakarta: Gramedia Widiasarana Indonesia, 

2002). 165. 
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Gambar 3.1 Rancangan one group pretest-posttest design 

 

 

  

 

 

Keterangan:  

O1  : Tes awal (pre-test) sebelum diberikan perlakuan 

X   : Perlakuan (treatment) penggunaan media video 

pembelajaran 

O2  : Tes Akhir (post-test) setelah diberikan perlakuan 

 

Pada penelitian ini subjek dapat berfungsi menjadi 

kelompok Kontrol (sebelum dikenalkan perlakuan video) 

dan kelompok eksperimen (setelah dikenalkan perlakuan 

video). Data yang diperoleh sebelum perlakuan berupa hasil 

belajar peserta didik disebut pretest (O1), dan setelah 

mendapat nilai, kemudian diberikan perlakuan 

menggunakan media video dalam pembelajaran untuk 

meningkatkan hasil belajar peserta didik (X). Setelah 

perlakuan, dilakukan postest (O2) untuk mengetahui hasil 

belajar peserta didik setelah diberikan perlakuan. Hasil post-

test akan menentukan perlakuan dengan menggunakan 

video dalam pembelajaran dapat meningkatkan hasil belajar 

peserta didik atau bahkan tidak ada perubahan dari hasil 

sebelumnya. Perbandingan antara O1 dan O2 berfungsi 

untuk menentukan seberapa besar perbedaan hasil belajar 

peserta didik yang diakibatkan dari perlakuan penggunaan 

video pembelajaran.   

2. Definisi Operasional. 

Variabel yang akan diteliti pada penelitian ini adalah 

hasil belajar peserta didik terhadap penggunaan video 

pembelajaran dimasa pandemi covid-19. Variabel penelitian 

pada dasarnya adalah segala sesuatu yang ditetapkan oleh 

penulis yang dipelajari untuk mendapatkan informasi, 

kemudian menarik kesimpulan. Variabel dapat dibedakan 

menjadi dua, yaitu variabel bebas dan variabel terikat. 

Variabel bebas adalah variabel yang mempengaruhi atau 

menyebabkan variabel terikat berubah dan variabel terikat 

Pre-test 

O1 

Treatment 

X 

Post-test 

O2 



40 

adalah variabel yang dipengaruhi atau dihasilkan dari 

variabel bebas.
3
 

Variabel-variabel penelitian yang terdapat dalam 

penelitian ini adalah: 

a. Variabel bebas yaitu penggunaan media pembelajaran 

video untuk meningkatkan hasil belajar peserta didik di 

kelas VIII-D MTs Nu Ibtidaul Falah. 

b. Variabel terikat yaitu hasil belajar peserta didik dan 

respon peserta didik terhadap penggunaan media 

pembelajaran video di kelas VIII-D MTs Nu Ibtidaul 

Falah 

 

E. Uji Validitas dan Reliabilitas Instrumen 

Penelitian ini dilakukan dengan menggunakan instrumen 

yang belum terstandar, maka perlu dilakukan untuk uji coba 

terhadap instrumen untuk menghindari hasil data yang tidak 

benar. Sebelum instrumen penelitian digunakan untuk 

memperoleh data maka instrumen perlu diuji dengan 

menggunakan validasi ahli, uji validitas butir soal, uji tingkat 

kesukaran soal, uji daya beda, dan uji reliabilitas. 

1. Validasi Ahli 

Validasi adalah suatu penilaian yang dilakukan oleh 

validator dengan tujuan guna memperoleh kevalidan baik 

instrumen maupun produk sehingga dapat digunakan dalam 

penelitian.
4
 Penilaian didasarkan pada pemikiran rasional 

dari 3 validator yaitu 2 Dosen IAIN Kudus dan 1 Guru MTs 

Nu Ibtidaul Falah. Jika terdapat saran atau masukan dari ke 

3 validator untuk merevisi maka perlu direvisi terlebih 

dahulu kemudian setelah direvisi dapat diujicobakan kepada 

peserta didik. 

a. Validasi Ahli Materi 

Uji validasi ahli materi bertujuan untuk menguji 

kelayakan pada materi baik dalam segi kesesuaian 

materi, sistematika materi, kurikulum materi dan 

berbagai hal yang berkaitan dengan materi 

                                                           
3 Supratiknya A, Metode Penelitian Kuantitatif & Kualitatif Dalam 

Psikologi, 1st edn (Yogyakarta: USD, 2015). 11-13. 
4 Bayu Pambudi Mada, ‘Validasi Terhadap Media Pembelajaran Video 

Tutorial Dan LKS Untuk Meningkatkan Kompetensi Gambar Potong’, Skripsi, 

(Unnes, 2015). 43. 
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pembelajaran.
5
 Instrumen divalidasi oleh dua Dosen IPA 

IAIN Kudus yaitu Bu Iseu Laelasari, M.Pd dan guru IPA 

di MTs Nu Ibtidaul Falah yaitu Bapak Said Arifatul 

Hakim S.Pd yang dibuat dengan 15 indikator. Berikut 

analisis data pada uji validasi ahli yang dapat diperoleh 

dengan rumus sebagai berikut:
6
 

 

Hasil Validasi =  
𝑆𝑘𝑜𝑟 𝑦𝑎𝑛𝑔 𝑑𝑖𝑝𝑒𝑟𝑜𝑙𝑒𝑕

𝑆𝑘𝑜𝑟 𝑚𝑎𝑘𝑠𝑖𝑚𝑎𝑙
 𝑋 100% 

 
Setelah divalidasi oleh validator ahli dengan 

menggunakan rumus diatas, Berikut hasil dari validasi 

materi, dapat dilihat pada tabel 3.1 

Tabel 3.1 Hasil Analisis Validasi 

Materi 

No. Ahli Materi Penilaian Kriteria 

1. Validator 1 81.66 % Layak 

2. Validator 2 78.33 % Layak 

Rata-rata  80.00% Layak 

 

Dari tabel 3.1 diperoleh hasil rata-rata persentase 

dari dua validator ahli materi sebesar 80% dengan 

kriteria layak. Terdapat masukan atau saran dari Bu Iseu 

Laelasari, M.Pd untuk direvisi seperti belum ada 

kesesuaian indikator berdasarkan materi yang digunakan. 

Validasi materi harus ditambahkan indikator ketika 

melakukan validasi terhadap materi sistem pernapasan 

manusia, agar validator dapat menyesuaikan susunan 

dari materi yang terdapat didalam video pembelajaran 

berdasarkan buku guru. Masukan dari validator 

kemudian direvisi sebelum diberikan kepada peserta 

didik untuk diujicobakan. 

                                                           
5 Edi Wibowo, ‘Pengembangan Bahan Ajar E-Modul Dengan 

Menggunakan Aplikasi Kvisoft Flipbook Maker’, Universitas Islam Negeri 

Raden Intan Lampung, 2018, 30–31 

<http://repository.radenintan.ac.id/3420/1/SKRIPSI FIX EDI.pdf>. 
6 Hariri Ihfan, ‘Pengembangan Multimedia Pembelajaran Interaktif (MPI) 

Materi Sistem Pernapasan Pada Manusia Dan Hubunganya Dengan Kesehatan 

Untuk Kelas VIII Di MTs Muhammadiyah 1 Dukuh Magelang’, Skripsi, (Unnes, 

2016). 51-52. 
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Pada uji validasi penyusunan soal bertujuan untuk 

menguji kelayakan soal yang akan digunakan dalam 

penelitian oleh ahli materi yaitu Dosen IAIN Kudus Bu 

Iseu Laelasari, M.Pd, dan Irma Yuniar Wardhani, M.Pd. 

serta Guru IPA MTs Nu Ibtidaul Falah Bapak Said 

Arifatul Hakim S.Pd. Berikut hasil validasi untuk 

penyusunan soal dapat dilihat pada tabel 3.2 

   Tabel 3.2 Hasil Analisis Validasi Penyusunan Soal 

No. Ahli Materi Penilaian Kriteria 

1. Validator 1 80,00 % Layak 

2. Validator 2 91,66  % Sangat Layak 

3 Validator 3 86,66 % Sangat Layak 

Rata-rata 86,11 % Sangat Layak 

 

Dari hasil analisis penyusunan soal yang terlihat 

pada tabel 3.2 diperoleh hasil rata-rata persentase 

86,11% dengan kriteria sangat layak, sehingga soal dapat 

digunakan dalam penelitian. Pada validasi penyusunan 

soal, Bu Irma Yuniar Wardhani, M.Pd.  memberikan 

masukan mengenai kesalahan pada penelitian kalimat. 

Kalimat yang digunakan untuk pretest dan postest 

terdapat typo sehingga perlu diperbaiki. Masukan lain 

seperti petunjuk pengerjaan, soal pretest dan postest 

belum terdapat petunjuk atau langkah untuk 

mengerjakan soal, sehingga membuat validator bingung 

terhadap soal tersebut. Selain itu kesalahan pada 

pemberian level kognitif untuk soal nomer 32. Level 

kognitif yang tepat untuk soal nomer 32 adalah C2 bukan 

C1. Dari beberapa masukan tersebut harus direvisi 

terlebih dahulu sebelum diujicobakann kepada peserta 

didik.   

Selanjutnya uji validasi untuk lembar kerja peserta 

didik yang bertujuan untuk menilai kelayakan LKPD 

yang nantinya akan diberikan kepada peserta didik 

setelah mengamati video pembelajaran pada materi 

sistem pernapasan. Berikut hasil validasi LKPD terhadap 

materi sistem pernapasan yang dapat dilihat pada table 

3.3 
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Tabel 3.3 Hasil Analisis Validasi Lembar Kerja Peserta 

Didik 

No. Ahli Bahasa Penilaian Kriteria 

1. Validator 1 81,66 % Layak 

2. Validator 2 78,33 % Layak 

Rata-rata 80,00 % Layak 

 

Hasil analisis LKPD yang terlihat pada tabel 3.3 

diperoleh hasil rata-rata persentase 80,00% dengan 

kriteria layak, sehingga LKPD dapat digunakan dalam 

penelitian. Terdapat masukan yang diberikan oleh Bu 

Iseu Laelasari, M.Pd untuk direvisi yaitu penelitian pada 

beberapa kalimat yang perlu diperbaiki. Validasi LKPD 

tidak begitu banyak masukan hanya saja ada beberapa 

kalimat yang typo dan pembuatan LKPD yang kurang 

rapi dalam segi warna sehingga perlu untuk direvisi.  

Pada uji validasi respon peserta didik bertujuan 

untuk menguji kelayakan respon peserta didik terhadap 

video pembelajaran pada materi sistem pernapasan yang 

dilakukan oleh Dosen IAIN Bu Iseu Laelasari, M.Pd dan 

guru IPA di MTs Nu Ibtidaul Falah yaitu Bapak Said 

Arifatul Hakim S.Pd. Berikut hasil validasi terhadap 

respon peserta didik pada materi sistem pernapasan yang 

dapat dilihat pada tabel 3.4 

Tabel 3.4 Hasil Analisis Validasi Respon Peserta Didik 

No. Ahli Bahasa Penilaian Kriteria 

1. Validator 1 80,00 % Layak 

2. Validator 2 80,00 % Layak 

Rata-rata 80,00 % Layak 

 

hasil analisis penyusunan soal yang terlihat pada 

tabel 3.4 diperoleh hasil rata-rata persentase 80,00% 

dengan kriteria layak, dan tidak ada catatan dari validator 

untuk merevisi, sehingga angket dapat digunakan dalam 

penelitian.  

b. Validasi Ahli Media 

Uji validasi ahli media bertujuan untuk menguji 

kelayakan media video pembelajaran pada materi sistem 

pernapasan berdasarkan pada segi aspek tampilan, 
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pengoperasian, dan penyajian.
7
 Validator yang mengkaji 

dalam uji validasi video pembelajaran online pada materi 

sistem pernapasan adalah Dosen IAIN Kudus Bu Irma 

Yuniar Wardhani, M.Pd. dan Guru IPA MTs Nu Ibtidaul 

Falah Bapak Said Arifatul Hakim S.Pd. Berikut hasil 

validasi dari ahli media dapat dilihat pada tabel 3.5 

Tabel 3.5 Hasil Analisis Validasi Ahli Media 

No. Ahli Media Penilaian Kriteria 

1. Validator 1 90,00 % Sangat Layak 

2. Validator 2 76,66% Layak 

Rata-rata 83,33 % Sangat Layak 

 

Dari tabel 3.5 diperoleh hasil rata-rata persentase uji 

kelayakan media video pembelajaran pada materi sistem 

pernapasan oleh kedua validator sebesar 83,33 % dengan 

kriteria sangat layak. Adapun masukan yang diberikan 

oleh Irma Yuniar Wardhani, M.Pd. adalah media video 

pembelajaran sudah cukup menarik, hanya saja perlu 

ditambahkan gambar penyakit dari gangguan sistem 

pernapasan agar peserta didik bisa lebih mudah 

memahami materi dengan jelas. 

 

2. Uji Validitas 

Uji validitas adalah suatu metode untuk mengukur 

kesahihan atau tingkat validitas suatu instrumen, agar 

instrumen yang diteliti dapat dikatakan valid, maka data 

yang diperoleh perlu diuji dengan menggunakan uji 

validitas. Pada hasil analisis data validitas instrumen soal 

terhadap hasil belajar peserta didik dapat dikatakan valid 

jika rxy > rtabel.
8
 Setelah instrumen disesuaikan dengan aspek 

yang akan diukur, maka selanjutnya akan diujicoba kepada 

sampel peserta didik dan dihitung menggunakan rumus 

                                                           
7 Ospa Pea, Yuanita Meishanti, and Panji Ardiansyah, ‘BIO-EDU : Jurnal 

Pendidikan Biologi Pengembangan Media Whiteboard Animation Berbasis 

Reading ’, 6.2 (2021), 156. 
8 Dyan Septiani Vega Pratika, ‘Pengaruh Penggunaan Media Video 

Pembelajaran Dalam Meningkatkan Motivasi Dan Hasil Belajar Peserta didik 

Kelas V Mata Pelajaran Fiqih Di Min 3 Ponogoro Tahun 2020/2021’, Skripsi, 

(Iain Ponogoro, 2021), 69. 
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Pearson yaitu korelasi product dengan bantuan software 

SPSS 16 for windows yaitu: 

a. Buka program SPSS 16.00 

b. Pilih menu Variabel View 

c. Masukkan nilai hasil prestest peserta didik 

d. Pilih menu Analyze → Correlate → Bivariate 

e. Masukkan nilai hasil prestest pada kotak Variables 

f. Klik Options → Means and Standard Deviation → 

Cross Product Deviations and Covariance → Next 

g. Klik ok sehingga akan muncul hasil analisis pada 

output 
9
 

Berdasarkan data hasil perhitungan yang telah 

dilakukan terdapat sebanyak 40 butir soal instrumen 

terhadap hasil belajar peserta didik. Pada 40 butir soal 

instrumen yang telah dihitung tersebut terdapat beberapa 

soal yang tidak valid setelah dilakukan uji coba instrumen. 

Berikut hasil analisis uji validitas instrumen soal hasil 

belajar yang dapat dilihat pada tabel 3.6 

Tabel 3.6 Hasil Analisis Uji Validitas Instrumen Soal 

Kriteria 
Nilai r 

hitung 

Nilai r 

tabel 
Nomor soal 

Jumlah 

soal 

Valid 
0,554 – 

0,738 

 

 

0,514 

1, 3, 4, 7, 13, 14, 

20, 26, 29, 33, 34, 

40 

12 Soal 

Tidak 

Valid 

0,014 – 

0,504 

2, 5, 6, 8, 9, 10, 

11, 12, 15, 16, 17, 

18, 19, 21, 22, 23, 

24, 25, 27, 28, 30, 

31, 32, 35, 36, 37, 

38, 39 

28 Soal 

 

3. Tingkat Kesukaran Soal 

Tingkat kesukaran soal dapat dilihat berdasarkan 

kesanggupan dan kemampuan peserta didik dalam 

menjawab soal tes. Uji kesukaran soal merupakan langkah 

untuk menguji soal tes dari segi tingkat kesukarannya, 

sehingga dapat diketahui pada setiap soal tingkat kesukaran 

                                                           
9 Anwar Ali, Statistika Untuk Penelitian Pendidikan Dan Aplikasinya 

Dengan SPSS Dan EXCEL, 1st edn (Kediri: IAIT Press, 2009). 9. 
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dengan kategori mudah, sedang, dan sukar. Tingkat 

kesukaran dapat dihitung dengan menggunakan rumus 

sebagai berikut: 

𝑃 =
𝐵

𝐽𝑆
 

Keterangan: 

P = indeks tingkat kesukaran 

B = banyak peserta didik yang menjawab soal itu 

dengan benar 

JS= jumlah seluruh peserta didik peserta tes
10

 

Soal yang digunakan dalam penelitian ini adalah soal 

pilihan ganda dengan jumlah 40 butir soal. Dari hasil uji 

analisis tingkat kesukaran dapat mengevaluasi butir soal 

yang telah dibuat tergolong layak atau tidak. Berikut hasil 

analisis tingkat kesukaran soal dapat dilihat pada table 3.7 

Tabel 3.7 Hasil Analisis Tingkat Kesukaran Soal 

Kriteria  
Tingkat 

Kesukaran 
Nomor soal 

Jumlah 

soal 

Mudah 1,00 5, 12, 25 3 

Sedang 0,40 – 0,87 

1, 2, 3, 4, 6, 7, 8, 

9, 10, 11, 14, 16, 

17, 18, 19, 22, 23, 

24, 28, 29, 30, 31, 

32, 34, 35, 36, 37, 

38, 39, 40 

31 

Sukar 0,20 – 0,27 
13, 15, 20, 26, 27, 

33,  
6 

 

4. Uji Daya Beda 

Daya beda merupakan kemampuan pada butir soal 

untuk membedakan antar kelompok dalam aspek yang ingin 

diukur sesuai dengan perbedaan yang ada dalam kelompok 

tersebut.
11

 Daya beda pada setiap butir soal dapat dihitung 

dengan menggunakan rumus berikut:
 12

 

                                                           
10 Priyono, Metode Penelitian Kuantitatif, ed. by Teddy Chandra 

(Surabaya: Zafatma Publishing, 2008). 136-138. 
11 Intan Utami, ‘Analisis Butir Soal Pilihan Ganda Ulangan Akhir Semester 

Genap Tahun Pelajaran 2014/2015 Mata Pelajaran PKN Kelas IV SD Di 
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𝐷 =
𝐵𝐴

𝐽𝐴
−

𝐵𝐵

𝐽𝐵
 

Keterangan: 

D  = Daya pembeda 

JA = Banyaknya peserta kelompok atas 

JB = Banyaknya peserta kelompok bawah 

BA= Banyaknya kelompok atas menjawab soal benar 

BB= Banyaknya kelompok bawah menjawab soal benar 

Dari hasil uji analisis daya beda menentukan kelompok 

mana yang memiliki kemampuan tinggi dengan kelompok 

yang memiliki kemampuan rendah, sehingga dapat 

memberikan nilai maksimal dalam mengukur tingkat hasil 

belajar peserta didik. Berikut hasil analisis tingkat 

kesukaran soal dapat dilihat pada tabel 3.8 

Tabel 3.8 Hasil Analisis Daya Beda Soal  

Kriteria 
Nilai Daya 

Beda 
Nomor soal 

Jumlah 

soal 

Sangat 

Rendah 

(-0,05) – (-

0,09) 
6, 9 21, 28, 31 5 

Rendah 
0,018 - 

0,196 

5, 8 11, 12 16, 24, 

25, 27, 32, 35, 36, 

38, 39 

13 

Cukup 
0,214 – 

0,321 

15, 18, 19, 22, 23, 

34, 37 
7 

Tinggi 
0,429 – 

0,625 

1, 2, 4, 10, 13, 14, 

17, 20, 26, 29, 30, 

33 

12 

Sangat 

Tinggi 

0,732 – 

0,857 
3, 7, 40 3 

 

5. Uji Reliabilitas  

Reliabilitas merupakan suatu pengukuran dimana 

instrumen dapat dipercaya atau diandalkan sehingga dapat 

dijadikan sebagai alat pengumpulan data karena instrumen 

tersebut sudah baik atau reliabel. Uji reliabilitas dapat 

                                                                                                                       
Kecamatan Depok, Sleman, Yogyakarta’ (Universitas Santa Dharma, 2016).27-

28. 
12 Muhammad Ali Gunawan, Statistika Penenlitian Bidang Pendidikan, 

Psikologi Dan Sosial, 1st edn (Yogyakarta: Parama Publishing, 2015). 134-135. 



48 

menggunakan rumus alpha Cronbach dengan tujuan untuk 

mencari reliabilitas instrumen yang mempunyai nilai alpha 

lebih besar dari 0,6. Adapun rumus yang digunakan untuk 

menghitung reliabilitas koefisien alpha yaitu: 

Rumus cronbach alpha (CA) =  
𝑘

𝑘−1
   1 −

Ʃ𝛿𝑏2Ʃ𝛿𝑡2 

Keterangan:  

CA = koefisien Cronbach alpha  

K = banyaknya pertanyaan dalam butir  

δb² = varian butir  

δt² = varian total 

Apabila suatu instrumen digunakan sebagai alat 

pengukuran sebanyak dua kali atau lebih terhadap gejala 

yang sama dan hasilnya tetap atau konsisten, maka 

instrumen tersebut dapat dikatakan reliabel.
13

 Berikut hasil 

analisis uji reliabilitas butir soal dapat dilihat pada tabel 3.9 

Tabel 3.9 Hasil Analisis Uji Reliabilitas Butir Soal 

Hasil 

Reliabilitas 

Indeks 

Reliabilitas 

Jumlah 

Item 

Soal 

Kriteria 

Reliabilitas 

0,821 0,6 40 Reliabel 

 

F. Teknik Pengumpulan Data 

Pada penelitian ini t eknik pengumpulan data merupakan 

prosedur dalam penelitian yang sangat penting untuk 

mengumpulkan data secara benar dan tepat. Penggunaan teknik 

pengumpulan data secara tepat maka akan memperoleh data 

yang objektif. Teknik pengumpulan data pada penelitian ini 

dilakukan dengan menggunakan teknik sebagai berikut: 

1. Tes 

Tes digunakan untuk mengukur ada atau tidaknya 

kemampuan hasil belajar peserta didik terhadap 

pembelajaran dengan menggunakan video. Bentuk tes yang 

akan diberikan kepada peserta didik adalah pilihan ganda 

yang berjumlah 10 butir soal yang akan dilakukan dua kali, 

tes tersebut berupa: 

                                                           
13 Setyowati, ‘Pengaruh Motivasi Belajar Terhadap Hasil Belajar Peserta 

didik Kelas VII SMPN 13 Semarang’, Skripsi, (Unnes, 2007), 73. 
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a. Tes awal (pre-test) 

Pre-test bertujuan untuk mengukur kemampuan dan 

pengetahuan peserta didik dalam memahami materi 

pembelajaran sistem pernapasan manusia sebelum 

dilakukan perlakuan dengan menggunakan video.  

b. Tes akhir (post-test) 

Post-test dilakukan untuk mengukur kemampuan dan 

pengetahuan peserta didik dalam memahami materi 

pembelajaran sistem pernapasan manusia setelah 

dilakukan perlakuan dengan menggunakan video 

pembelajaran. 

2. Wawancara 

Wawancara adalah komunikasi antara dua orang atau 

lebih yang dirancang untuk memperoleh informasi dengan 

mengajukan pertanyaan untuk tujuan tertentu. Wawancara 

sangat penting dalam pengumpulan data karena bertujuan 

untuk menemukan masalah yang akan diteliti. Pada 

penelitian ini penulis melakukan wawancara awal ketika 

observasi untuk mendapatkan informasi yang jelas dan 

akurat, yang bersumber dari guru IPA di sekolah MTs Nu 

Ibtidaul Falah. Kegiatan wawancara dilakukan dengan salah 

satu guru IPA di MTs Nu Ibtidaul Falah mengenai proses 

pembelajaran dimasa pandemi covid-19 terlebih pada materi 

pembelajaran sistem pernapasan manusia.  

3. Kuesioner atau angket 

Angket merupakan teknik pengumpulan data yang 

digunakan untuk mengukur pemahaman pada materi 

terhadap hasil belajar peserta didik dengan menggunakan 

video pembelajaran. Angket respon peserta didik terhadap 

penggunaan video pembelajaran dilakukan dengan 

menggunakan skala likert. Hasil angket dapat berupa sikap 

peserta didik yang mendukung (pernyataan positif) maupun 

menolak (pernyataan negatif). Analisis respon peserta didik 

dihitung dengan rumus sebagai berikut:
14

 

                                                           
14 Riana Sakti Veroza, ‘Pengaruh Model Pembelajaran Kooperatif Tipe 

Think Pair Share (TPS) Pada Materi Sistem Pernapasan Manusia Untuk 

Meningkatkan Aktivitas Dan Hasil Belajar Peserta didik Di MTSN 4 Banda 

Aceh’ (UIN Ar-Raniry, 2019).40. 
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𝑝 =  
𝑓

𝑛
 𝑥 100% 

Keterangan: 

f = frekuensi persentase 

n = jumlah frekuensi/banyaknya kelas 

p = nilai persentase. 

 

Dengan kriteria persentase respon peserta didik yag 

dapat dilihat pada tabel 3.10 sebagai berikut:
15

 

Tabel 3.10 Persentase Kategori Respon Peserta Didik 

No Presentase Kategori 

1. 0-40% Sangat Tidak tertarik 

2. 41-60% Tidak tertarik 

3. 61-80% Tertarik 

4. 81-100% Sangat Tertarik 

 

G. Teknik Analisis Data 

Penelitian itu perlu diukur dengan menggunakan suatu 

metode dan instrumen yang sesuai agar bisa mendapatkan data 

yang relevan. Penggunaan teknik pengumpulan data yang tepat 

dapat memperoleh data yang objektif. Data yang telah 

diperoleh berasal dari nilai kognitif hasil belajar peserta didik 

yang berupa nilai tes kemampuan awal dan kemampuan akhir 

peserta didik pada materi sistem pernapasan manusia yang 

dianalisis dengan menggunakan statistika inferensial yaitu uji-

T. Uji-t dapat dilakukan dengan menggunakan bantuan 

software SPSS 16 for windows. Berikut tahapan yang harus 

dikerjakan untuk analisis data antara lain: 

1. Uji Normalitas 

Uji normalitas digunakan untuk menguji normal atau 

tidaknya data yang dianalisis pada populasi yang akan 

diolah. Uji tersebut dimaksudkan untuk mendeteksi 

penyebaran data dalam satu variabel yang digunakan dalam 

penelitian. Pengujian ini menggunakan kolmogorov- 

smirnov dengan bantuan software SPSS 16 for windows. 

                                                           
15 Aidil Azhar, ‘Pengaruh Penggunaan Model Pembelajaran CTL Terhadap 

Hasil Belajar Peserta didik Pada Materi Pesawat Sederhana Kelas VIII Di MTs 

Darul Aman Aceh Barat’ (UIN Ar-Raniry, 2017). 
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Adapun cara yang digunakan untuk uji normalitas antara 

lain: 

a. Buka program SPSS 16.00 

b. Isi kolom name dengan hasil pretest, dan kolom kedua 

dengan hasil postest 

c. Pilih menu variabel view 

d. Masukkan data yang akan dianalisis 

e. Lakukan analisis menggunakan menu Analysis → 

Legacy Dialog → 1 Sample K-S 

f. Masukan semua variabel pada kotak Test Variable List 

g. Kemudian klik ok 

Kriteria pengujian pada output kolmogorov- smirnov 

adalah jika nilai sig < α = 0,05 maka data dapat dikatakan 

tidak berdistribusi normal sedangkan jika nilai sig > = 0,05 

maka data tersebut berdistribusi normal.
16

 

2. Uji Homogenitas 

Uji homogenitas digunakan untuk mengetahui suatu 

kelompok yang memiliki memiliki variasi yang homogen 

atau tidak. Uji tersebut dilakukan dengan menggunakan uji 

levene dari nilai pre-test dan post-test terhadap kelompok 

dengan bantuan program software SPSS 16 for windows. 

Berikut cara yang digunakan untuk uji homogenitas antara 

lain: 

a. Buka program SPSS 16.00 

b. Isi kolom name dengan variabel hasil belajar dan kolom 

kedua dengan kelompok  

c. Pilih menu Variabel View 

d. Masukkan data yang akan dianalisis 

e. Lakukan pengujian homogenitas dengan uji leavene 

statistic 

Pilih menu Analyze → Compare Means → one-way 

anova 

f. Masukan variabel hasil belajar ke kotak Dependen List 

dan kelompok ke kotak Factor List 

g. Klik menu Option dan pilih Homogenity of variance test 

h. Kemudian pilih Continue lalu klik ok 

                                                           
16 Nuryadi and others, Dasar- Dasar Statistik Penelitian, 1st edn 

(Yogyakarta: Sibuku Media, 2017). 79. 
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Taraf signifikasi yang digunakan dalam uji 

homogenitas adalah α = 0,05. Suatu data dapat dikatakan 

varian homogen yaitu apabila t hitung > dari 0,05 sedangkan 

jika suatu data memiliki t hitung <  dari 0,05 maka varian tdak 

homogen.
17

 

3. Pengujian Hipotesis 

Dalam penelitian ini setelah semua data terkumpul dari 

hasil tes, maka selanjutnya akan dianalisis dengan 

menggunakan uji hipotesis. Uji hipotesis pada penelitian ini 

dilakukan dengan menggunakan uji-t atau T-test melalui 

program software SPSS 16 for windows. Kriteria yang 

digunakan untuk uji-t adalah pada alpha dengan nilai 0,05 

atau 5%. Adapun langkah-langkah yang digunakan untuk 

melakukan analisis uji-t antara lain:  

a. Buka program SPSS 16.00 

b. Pilih menu Variabel View 

c. Masukkan data yang akan dianalisis  

d. Pilih menu Analyze → Compare Means → one Sample 

T-test 

e. Pindahkan variabel hasil belajar ke test variabel dengan 

memilih variabel tersebut kemudian klik tanda panah ke 

kanan di jendela tersebut. Dan isikan test Value dengan 

T hitung yang dijadikan perbandingan 

f. Klik Option pada jendela One Sample T-Test kemudian 

muncul jendela berikutnya. Isikan derajat keyakinan 

sebesar 95% α = 0,05 

g. Kemudian klik continue pilih ok 

h. Hipotesis uji   

1) Ho = tidak terdapat perbedaan pada hasil belajar 

peserta didik 

2) Ha = terdapat perbedaan pada hasil belajar peserta 

didik 

Apabila suatu data mempunyai nilai thitung lebih besar 

dari nilai ttabel (sig > 0,05) maka Ho diterima dan Ha ditolak. 

Namun sebaliknya jika suatu data memiliki nilai thitung lebih 

                                                           
17 Didik Setyawarno, ‘Panduan Statistik Terapan Untuk Penelitian 

Pendidikan’, FMIPA UNY, 1.1 (2016), 29–30. 
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kecil daripada ttabel (sig< 0,05) maka Ho ditolak dan Ha 

diterima.
18

 

4. Uji N-Gain 

Skor gain ternormalisasi (N-Gain) menunjukkan 

peningkatan kemampuan siswa. Perhitungan nilai N-Gain 

ini digunakan untuk melihat perbedaan peningkatan hasil 

belajar peserta didik ketika dilakukan pretest dan posttest. 

N-Gain dapat dihitung dengan menggunakan rumus sebagai 

berikut:  

𝑁 − 𝐺𝑎𝑖𝑛

=  
𝑁𝑖𝑙𝑎𝑖 𝑝𝑜𝑠𝑡𝑒𝑠𝑡 − 𝑁𝑖𝑙𝑎𝑖 𝑝𝑟𝑒𝑡𝑒𝑠𝑡

𝑁𝑖𝑙𝑎𝑖 𝑚𝑎𝑘𝑠𝑖𝑚𝑢𝑚 − 𝑁𝑖𝑙𝑎𝑖 𝑃𝑟𝑒𝑡𝑒𝑠𝑡
 

Data yang diperoleh dari jawaban siswa pada soal 

pilihan ganda pre-test dan post test akan dicari sejauh mana 

peningkatan pengetahuan hasil belajar dengan rumus 

tersebut. Berikut disajikan data hasil nilai N-Gain yang 

dapat dilihat pada tabel 3.11 

Tabel 3.11 Hasil Analisis Uji N-Gain Hasil Belajar 

Kriteria N-Gain Ketentuan N-

Gain 

Jumlah 

peserta Didik 

Tinggi  0,71-1,00 G > 0,7 9 

Sedang  0,33-0,66 0,3 < G < 0,7 24 

Rendah  0,25 G < 0,3 4 

 

 

                                                           
18 Sunjoyo and others, Aplikasi SPSS Untuk SMART Riset (Bandung: 

Alfabeta, 2013). 


